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SUBMISSION OF ARTWORK

{(Where possible) always submit your images beth digital as on hardcopy.

LINE ART IMAGES

« Please send in as Black & White TIFF files, with a minimum resolution of 800 dpi.
s Please send in as EPS files, absolute minimum line width of 0.5 pt, preferred minimum line width

of 1 pt. Do not place bitmap images within the EPS file, but send these in as TIFF instead, as indicated
above.

Note: Please note that when graphs are produced in software such as Word or Excel, the default is 1o
display the graph lines in color. These types of colored thin lines are difficult to reproduce, and
therefore we would like to encourage the authors to submit such graphs in black & white with different
types of dashed lines for total clarity.

HALFTONE IMAGES

» Please send in Greyscale TIFF files, with a minimum resolution of 300 dpi, or 500 dpi when it
includes lettering.

COLOR IMAGES
= Please send in color images as CMYK encoded (not RGB encoded; note 1) TIFF or EPS files with a
minimum resolution of 600 dpi.

o If you are only able to send in JPEG files, please make sure that these are saved at the highest
possibie quality, with absolute minimum compression. (Please see note 2 belaw).

Note 1: Piease note that RGB encoded color images will allow for more colers than CMYK encoded
images, which you can reproduce (on paper). These are only good for online purposes and CD-
Rom/finteractive productions.

Before printing these images need to be converted to CMYK, and colors may appear slightly different.

Note 2: JPEG files can somelimes present problems as the compression algorithm used throws away
some of the image information every time you "save” the file. When such a file needs adjustments, then
more information will be lost the next time the file is saved. Therefore we would like to encourage
authors to send in their files in TIFF (or EPS) format instead of JPEG.

Also make sure when images are embedded in Word to always send the original images {Hardcopy
and or TIFF/EPS files) along with the Mss.
Images embedded in Word are not suitable for reproduction.



GLOSSARY

RESOLUTION

The number of pixels that can be aclivated on-screen at one time, expressed in the horizontal value by the
vertical value (8.9., 1024 by 768).

BITMAFP IMAGE

A graphic image stored as a specific arrangement of screen dots, ar pixels. Web graphics are bitmap images.
A graphic, which is defined by specifying the colours of dots or pixels, which make up the picture. Also known as
raster graphics. Common types of bitmap graphics are GIF, JPEG, Photoshop, PCX, TIFF, Macintosh Faint,
Microsoft Paint, BMP, PNG, FAX formats, and TGA.

BITMAP (2)

A bitmap is an image format that defines an image only in terms of black and white. A bitmapped image is used
normally for Iine art because its elements can only be black and white, unlike a greyscale image. In general, a
bitmapped image will require a higher resolution to render good guality line art (1000 dpi or higher). A bitmagpped
image is also known as a 2-bit image. A bitmap image uses a gric of individual pixels where each pixel can be a
different colour or shade. Within the pixel, the colour is solid. In order to simulate a halftone, each subseguent
pixel can have a slightly lighter or darker colour. Whenever the resolution is too low (or the graphic is enlarged toc
much}, a pixel-griented graphic hecomes jagged.

CAMERA READY ART
Material given to the printer that needs no further work befare being passed on to the camera department.
Camera copy should be clean, free of glue or trash, flat, and printed in dark ink_ Laser prints, printed material, and
other good quality originals can be considered "camera-ready”.

CMYK

Stands for the colours Cyan-Magenta-Yellow-Black. In print design, colours are defined as a percentage of each
of these 4 colours. For example, the CMYK abbreviation for the colour black would be 0-0-0-100. In contrast,
display devices {i.e. computer monitors) typically define colours using RGB.

tyan Wugeets Teler ek

CMYK (Cyan, Magenta, Yellow, Black) (2)

CMYK stands for the four-colour printing process {process printing) that uses the standard inks Cyan, Magenta,
Yellow and Black. it is also known as subtractive colour. The colour black is achieved by the presence of all inks.
All colour work submitted to Swets & Zeitlinger Publishers is ideally saved as a CMYK file. Basically, each colour
can be achieved by using Cyan, Magenta and Yellow, where Black is used to give correct neutral tones and to
add detail.

COMPRESSION

A method of packing data in order to save disk storage space or downlead time. JPEGS are generally
compressed graphics files. Compression is a technigue to make a file or a data stream smaller for faster
transrmission or o take up less storage space.

DPI

Stands for dots per inch. CP| specifies the resolution of an output device, such as a printer or printing press
machine. Print resolution usually runs from 300-1200 dots per inch on a Laser Printer and 125-225 dots per inch
for photographic images on a print brochure. (For information on input device measurements see ppi.}.



DP1(2)

(or PPI) Dots-per-inch (or Pixels-per-inch) stands for the number of pixels that are defined within the boundary of
an inch, and is often referred to as the resolution of the image. The more correct term is pixels-per-inch, but
dots-per-inch is still used widely.

DUOTONE

A common printing technique by which a haiftone is printed in two ink colours-most often black and another colour
{screen angles 45 degrees apart).

EPS.

ENCAPSULATED POST SCRIPT. A standard format for saving object-orented graphics. Some cormmon
packages that support EPS files are lilustrator, Freehand, and CarelDraw!

EPS. (2}

EPS stands for the Encapsulated PostScript format from Adobe. An EPS file is an image that has been created
using the language of PostScript, and is generally resolution-independent because it has been created using
vectors {unfess it contains an ‘embedded’ bitmap, like a TiFF file, then the TIFF file's resolution is restricted by its
dpl). Because it is the vector that draws the image, the computer can draw the image at any resolution. The
computer can thus determine at what resolution it is 'o draw the image (or portion of the image) on the printing
device to which it is connected. An EPS file is normally used for combination artwork or charts and graphs.
Generally, an EPS file cannot be edited reliably in any other program than that which created it. An EPS image
may contain actual text. To avoid having font conversion problems, please make sure that the texts within the
EPS are replaced by outlines {this is normally an option in packages such as Adobe lllustrator).

GIF

Stands for Graphics Interchange Format. GIF images are the most widely used graphic format on the web. GIF
images display up te 256 colours.

GIF (2}

GIF stands for ‘Graphic Interchange Format’. This is an image format that is geared specifically towards computer
screen representation. Its resolution is thus normally very low (72 dpi, or that of your computer screen), making it
undesirable, or sometimas even unusable, for printing purposes.

GIF {2)

GRAPHICS INTERCHANGE FORMAT. Compressed bit-mapped or raster graphics, limited to 256 colours.
Current popular use is for web pages.

FOUR COLOR PROCESS
The four basic colours of ink (yellow, magenta, cyan, and black) which reproduce full-colour photographs or art.

HALFTONE

Picture with gradations of tone formad by dats of varying sizes. This process is used to reproduce art such as
photographs ar continuous tone drawings.

GREYSCALE

Greyscale stands for an image type that defines how the information in the image is to be stored and imaged. A
greyscale image is sometimes referred to as an eight-bit image. This format is generally used for haiftones
because it stores the information for each pixel as a level of grey. There are 256 levels of grey in a halftone.



HARD COPY

A paper printout of a file from a disk. Usually requested from customers who are providing their own keystrokes
on a disk.

JPEG

Stands for Joint Photographic Experts Group. File format for full-colour and black-and-white graphic images.
JPEG images allow for more colours than GIF images and are usually smaller in size.

JPEG (2)

Joint Photographic Experts Group. A compressed file, usually of a photograph, that reduces the amount of data
nesdad to display a full-colour bitmap. Usually results in loss of quality. Also used for web pages.

PICT

Another type of image format. A PICT file an contain black and white, colour, or greyscale information, as can a
TIFF or EPS file. A PICT image uses a language called QuickDraw to render the graphic. QuickDraw is limited in
precisian and cannot contain complex curves or special text effects, making a PICT image a bad choice for image
setting to film or plate. A PICT file is acceptable for laser printer or low-resolution output,

RGB {Red, Green, Biueg)

Colour process used by computer displays. The presence of all three colours as light waves is perceived by the
eye as white; the absence of light is perceved as black. This is also known as additive colour. RGB colour is very
different from CMYK colour. The amount of colours that can be generated by RGE moede is much larger than
those that can be generated by CMYK. Although graphics created and saved in RGB display well on the Web,
computer screen displays, and CD-ROM products, they can never be used in high-quality printed products.
All colour artwork submitted to Swets & Zeitlingar Publishers in eleclronic form must be in CMYK. RIP Rasterized
Image Processor. A PostScript interpreter that plots images onto output devices such as image setters and plate
setters.

TIFF

Tagged Image File Format. A type of image file format, TIFF files can include colour or grayscale information.
Its rasolution or dpi determines the quality of the image. If the resolution is too low, the image will appear jagged
or have a stair-stepped effect. Once the resolution has been determined, either by scanning or by saving in an
image-manipulation software package. it cannot be upgraded or increased to improve quality. The Tagged Image
File Format TIFF is a bitmap format developed for exchanging documents between different applications and
platforms. TIFF is probably the most popular image format in desktop publishing. TIFF files ¢an support 1, 4 or &
bits of information per pixel. up to 4 channeis (e.q., CMY¥ for four-colour printing) and various types of
compression and encoding (LZW compression being the most commoen). TIFF files are generally reliable for
printing and cross-piatform conversion, but beware, some applications will not import certain types of TIFF files.
TIFF files can be saved in either Macintosh or Windows formats.

WORKING FILES

Files that have been used to generate a graphic file such as an EPS file. Software applications such as
Macromedia FreeHand, Adobe illustrator, and QuarkXPress can alt generate EPS files. The editable application
file is normally called the working file, and will have an application-specific extension (such as PSD for Adobe
Photoshonp files). These types of files are also sometimes referrad to as ‘native files'.

Lossless Compression

in graphic design, lossless compression refers to a data compression technigue where the file guality is preserved
and no data is lost. Lossless compression is commonly used on GIE images, but can only reduce file size to
about half of its original size. Lossy compression, by contrast, eliminates some data can further decrease file size.

Lossy Compression

A term coined by graphics programmers to refer to a technique of shrinking file sizes by giving away some
precision of detail. JPEG is an example of a file that is compressed this way. By reducing the so-called quality of a
picture when you save it, you can make the file size smaller. Many photos can take of loss of fine detail kefore it
becomes noticeable on a web page.



Guidelines to create PDF files

1.

Store CP1_AR_PDF1.7 joboptions in the following directory on your C-drive
Locally installed Acrobat Software

C:\Program Files\Adobe\Acrobat 7.\Distillr\Settings

Network installed Acrobat software

C:\Documents and Settings\All Users\Documents\Adobe PDF\Settings

Or

C:\Users\Public\Documents\Adobe PDF\Settings

2.

Go to the print option in the file menu and choose Adobe PDF as printer.
Screen below should be visible
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Choose CPI_AR_PDF1.7 joboptions in the default settings

5.
[f you want to check if all letterfonts are included, click on edit



6.

This screen will pop-up
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Click on folder fonts and this screen will pop-up
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8.

Be sure that the below mentioned 2 boxes are ticked on
Z Embed all fonts
~ Subset embedded foats when percent of characters use is less than 100%

9,
If all of this is OK, click on cancel until you see the screen as mentioned under point 3

10.
Now you can click on OK. PDF file with CPI_AR_PDF1.7.joboptioms will be generated.
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Taylor & Francis Group

License to Publish for Contributors to Proceedings

The License ensures that the Publisher has the Author’s permission ta publish the Contribution.

Title of Contribution

Author{s})

Name of Proceedings/ Conference
Smart and Resilient Infrastructure for Emerging Economies: Perspectives on Building Better

1. The Author hereby assigns to the Publisher the right to publish the said Contribution in print and in efectronic
form and translations of it wholly or in part throughout the World during the full term of the publishing agreement
including renewals and extensions and all subsidiary rights.

2. The Author hereby warrants that he has full power te make this Agreement, that he is the Author of the
Contribution, that the Contribution is original, and has not previously been published in any form and is in no way
whatever a violation or infringement of any existing copyright or license, er duty of confidentiality, or duty to
respect te privacy, or any other right of any person or party whatsoever, that it contains nothing libellous, that all
statements therein purporting to be facts are true and that any recipe, forrmula or instruction contained therein
will not, if followed accurately, cause any injury, illness or damage to the user, The Author further warrants that
the Contribution contains n¢ obscene, improper or blasphemous material nor is in any other way unlawful.

3. The Authar retains the right to republish the Contribution in any printed collection without charge and subject

only to notifying the Publisher of the intent to do so and ensuring that the publication by the Publisher is properly
credited.

4. The Author guarantees that the Contribution is not under consideration for publication elsewhere, and that any

necessary permission to quote from other sources has been obtained. {Copies of any such permission should be
sent with this form.)

5. The Author declares that any person named as co-author of the Contribution is aware of the fact and has agreed
to being so named.

6. The Author dectares that, if the License to Publish form has been downloaded from the Publisher’s website or
sent by e-mail, the form has not been changed in any way without the knowledge of the Publisher.

To be signed by the Author, also on behalf of any co-authors.

Name Date

Signature

Please return this signed form promptly to the Editor(s) of the Proceedings. Thank you.

CRC Press / Balkema ~ Taylor & Francis Group, an informa business
E-mail, enquines@taylorandfrancis.com
www.routledga.com — www.taylorandfrancis.com

Information Classification: General



Cat# Author: Chapter

PERMISSION VERIFICATION FORM (PVF)

This form must be completed and returned even if there are no figures or tables in your section

Author & Chapter Intormation

{{Print of ype name )

(Bigm) {Date)

(Chapter ude) {Chapter nurnher)

[] Option A/No Permission Required - My work, text/figure(s)/table(s), is otiginal, has not been published
before, or is in the public domain.

[[] Option B/Written Permission is Required - I, the author, will obtain written permission from the copyright
owner for the materials that have been published before and requires permission via one of the following methods:
¢  Compleung the attached Copyright Permission Request form (page 2).
*  Making an online request directly to the copyright holder and/or contact pezson.
*  Contacting the Copyright Clearance Center woww.copyright.com

Pcrmissions Required

T&F werk Source Informadon Permission has beer
{Fig or Tuble Pages & Requested | Received
number/Text : Author Title Publisher Ye‘ar (YES/ ND) | (YES/NO)
Excerpt} Published " grants must be submitted

Important: Please submit the completed PVF and copies of the CPR together with your final manuscript



Cat# Author: Chapter

COPYRIGHT PERMISSION REQUEST

To: From:

Contact: Contact:
Address: Address:
City/St/Zip: City/St/Zip:
Country: Country:
Full Tel No.: Full Tel No.:

[ am preparing material for:

in

to be published by Taylor & Francis. I hereby request permission for non-exclusive world rights in this and all
subsequent editions, revisions and derivative wotks, in English and in foreign translations, in all formats, including
CD-ROM and electronic roedia, from the following:

[ would like to include the following material from your publication:

Title:

Author:

Publication Date:

Text utle and page:

Figure(s): Table(s):

Will appear in the T & F publication as text ot labeled as:
Figure(s): Table(s):

Please sign the release form below. Suitable credit will be given in the use of the material; if you have a preferred
statement, please indicate it below. If you are not the copyright controller, please indicate to whom [ should apply.
Your prompt consideration of this request is appreciated.

Yours very truly,

Requestor

1 {we) grant the permission requested above.

By: Date:

Taylor and Francis Use Only
Cat number:

Chapter:
Contributor:

Important: Please submit the completed PVF and copies of the CPR together with your final manuscript
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TITLE OF THE CONFERENCE:
smart and Resilient infrastructure for Emerging Economies: Perspectives on Building Better (DIl 2024)

DATE:
24-26 July 2024

LOCATION OF THE CONFERENCE/SYMPOSIUM:
Livingstone, Zambia

PLEASE NOTE:

When an Author submits a paper or article to the Publisher, the Author is obliged to sign and
return a Consent to Publish Form, which will be provided by the Editor of the proceedings.
With submitting a paper for publication the Author agrees to transfer the copyright of his paper to
the Publisher, and the Publisher has the right to publish the paper.

Furthermore:

All papers/documents should be delivered in * pdf format that was compiled from *.doc (Word) files or from
another software program, using the option ‘embedded fonts' in pdffile preparation (see guidelines to
create PDF files.pdf). Pdf-files prepared from scanned documents can not be accepled. In addition to the
“.pdf fife, the original source file (*.doc) should be provided as weff

all papers should be delivered in electronic form (MsWord or LaTeX) as weil as identical Acrobat PDF
file.

- the deadline for submission of full papers is 20 March 2024
- the maximum number of pages per fuf paperis 3 pages for keynate speakers
- the maximum number of pages per fulf paperis 9 pages for regular contributions
The attached job-options (CPI_AR_PDF1.7) should be used to create the pdf file.

Be sure that all letter fonts are included when you create the PDF file (see guidelines to create
PDF files.pdf.

PLEASE SUBMIT YOUR PAPERS THROUGH THE ONLINE SUBMISSION SYSTEM QN THE
CONFERENCE WEBPAGE:

Online Submission System (Full Paper): httgs:g[agg.oxfordabstrads.comgstagegg13145,{submitter

Emait Address for Correspondence; RliConference@uj.acza

Contact person:

Name editor/arganizer: Prof. Innocent Musonda

Full postal address: 40 Hampton Avenue, Johannesburg
City: Johannesburg

Country: South Africa

Tel: +27 11 559 6417

E-mail:imuspnda@uj.ac.za

FOR ADDITIONAL INFORMATION, SEE THE CONFERENCE WEBSITE;
https;//diiconference org/

PLEASE FIND BELOW SEVERAL FILES THAT CAN BE USED TO PREPARE YOUR PAPER:
o Read Me.pdf: instructions on how to get started and use the files in this zip
o Termpiates.zip

o 2columns A4_Word.zip>>

o 2columns A4_LaTex.zip>>

CRC Press/ Balkema. P.Q. Box 447, 2300 AK Leiden. The Netherdands, Tel 31715243082, Fax +31 71 5234571
http:# www balkema nl
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Artwork.pdf: Instructions on how to submit your artwork (figures)

Guidefines to create PDF file.pdf: how to make a pdf file

Harvard ens

License to Publish_Proceedings

Permission Verification Form.doc: Form indicating that afl required permissions have been sought and
obtained (if applicable — if in doubt please consult the files Permissions+Flow+Chart.pdf and T&F
Permission FAQ.pdf}

[o RN o BN o B SR o]

Before starting, make sure that you have a PostScript printer installed. Microsoft Word users should select the
corract files for their printer: A4 paper size (21 x 28.7 cm, European size), or Letter paper size (8 1/2"x 11,
American siza). Copy the files which you will be using to a new directory and keep the original file as a
backup.

MICROSOFT WORD USERS

Start MS Word, Close the empty fite which appears on your screen (Close in File Menu). Now open the file
B1ProcAd.doc (if you have a printer printing on A4 size paper - European standard) or B1ProcLe.doc (if you
have a printer printing on Letter size paper - American standard) (Open in File Menu). Print this document.
It gives detailed instructions on how to proceed when you stili have to type your paper and also when you
wanit to use the text from an old file. After you have read the first two pages of these instructions you are ready
to start.

Note that you shouid always use the tag "First paragraph” after a heading. For the rest of the text use
"Normal fext”. When importing figures always set the paragraph tag on "Figures”. Figures cannat be imported
on the paragraphs tag. Use only the headings 1, 2, and 3 prepared by the Publisher.

Quick start for MS Word users

1. Copy the correct template file to the template directory. The name of this directory can be found in File
Locations of Options {Tools Menu).

2. Start MS Word and select the template file in "New” (File Menu).

3. Renare this new file in "Saving As" (File Menu).

You are now ready [0 type your paper (see 4-7 below), orfand to insert text from another file (see 810 befow).

4. Type the correct title, author{s) and affiliation(s), and delete okl text without deleting the return at the end of

the line.

Type your abstract behind "ABSTRACT: .

Type the text of the first heading and delets old text without deleting the return at the end.

Now type the text of your paper using tag "First paragraph’” for all paragraphs which follow after a heading and

tag "Normai, text” for all other normal paragraphs. Figures should be placed in paragraphs with a "Figure™ tag

and equations with a "Formula" tag.

%. Toinsert text from another file open, that file as well, select (Mouse) the text to be copied (Edit Menu), and paste
{Edit Menu) it into the new file. In the Window Menu you can switch betwaen opened files. The title, author(s),
and affiliation(s) should not be copied completely. First type the first word of each line and then copy the rest of
each line one by one. Copy only the text of your abstract and place it behind the word "ABSTRACT: .

¢. Check f sefting of paper size and margins (Page Set Up in File Menu), and Columns (Format Menu) are still
cofrect (see table 1 in instruction file).

10. Change the old tags for the new Balkema tags (see 7 above). Before doing this apply automatic formatting:
From the Format Menu select AutoFormat and click AutoFormat now.
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FINAL NOTE TO ALL AUTHORS

Please see to it that your paper has the same typography as the specimen paper enclosed, whether you used
the CRC Press / Balkema tempiates or not. The publisher will reduce your paper to 75% and print it in
black. For this reason, please check if your figures will be legible after reduction.

It is also very important that you submit your artwork/figures both embedded into Microsoft-Word as in a
separate single fite, with a preferred format of TIFF or .EPS << see for reference Artwork.pdf

Please contact Mr. Lukas Goosen, Production Manager
E-mail address. ukas.goosen@taylorandfrancis.com
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